4. User Manual - Student

This page contains User Instructions on how to use the JupyterHub environment on Lisa. This environment is hosted at surfsara.nl, using a typical URL http
s:/ljupyter.lisa.surfsara.nl/<coursename>.
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Basic Topics

Receive login credentials

Before you start, you will receive an email containing your login-ID and a temporary password. The e-mail will look like the following:

From: hel pdesk@ur f sar a. nl

Subject: SURFsara service for user; *****xx
Message: Dear ****
Your password has been changed:
login: ****
password: ****
We urge you to change your password as soon as possible. Use this method:
- point your web browser on:
https://portal.surfsara.nl/password
We strongly advise NOT to use your former password.
Questions and renarks can be send to hel pdesk@urfsara.nl.

- The SURFsara System Admi nistration

Alternatively, the login-ID and password may have been provided by your teacher.

First time setup

Before logging in, you will need to

® accept the Usage Agreement;
® change your temporary password.

Both can be done at https://portal.surfsara.nl/. Please select "Usage Agreement” or "Change Password" from the menu's on the left.
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Though you can login to the Jupyter Hub without having accepted the Usage Agreement, you will not be able to launch a Jupyter Notebook server.
Therefore don't forget to accept the Usage Agreement.

Logging in and Profile selection

Each course uses it's own Jupyter Hub. The Jupyter Hubs are running at https://jupyter.lisa.surfsara.nl/<coursename>. The <coursename> will be provided

to you by your teacher.

After logging in, you will see the following screen:

: Jupyterhu b Home Token Admin lcursQ00 | ® Logout

Server Options

Select a job profile:

SURF jupyterhub pilot - outside course work v

You are now in the Jupyter Hub. The Jupyter Hub can be used to start a Jupyter Notebook server. To do this, there are two profiles:

® one 'outside course work' (or 'homework') profile
® one 'course’ profile.

The descriptions are quite self explanatory: the first one is meant for outside course hours, the others are meant to be used during course hours. To start a
Jupyter Notebook server, select the desired profile, and click 'Start'.

Outside course hours, only a limited number of slots are available to start Jupyter Notebook servers. This means not all students can run Jupyter
Notebooks at the same time. Usually, this should not be a problem, but if many other students are already working, trying to start your notebook may result
in a timeout. If that happens, there are no more slots available, and you will have to wait until another student finishes his/her session.



All profiles intended for course hours start Jupyter Notebook servers in a reservation that is large enough to accommodate all students at the same time.
This reservation is present only during pre-specified course hours, hence it is important to select the right profile.

The Jupyter Notebook session

After launching a Jupyter Notebook server, you should see something similar to the following screen

: JUu p)’ter hub Logout || Control Panel
Files Running Clusters

Select items to perform actions on them. Upload || New - || &
Jo | ~ Wi Name«  LastModified = File size
[J [0 Example_folder een paar seconden geleden
O & Course 01.ipynb 3 minuten geleden 726

where your teacher might have already prepared some material for you to work with (in this example ‘Course_01.ipynb' and the 'Example_folder").

This view shows the files and folders present in your home directory.

Basic navigation

You can browse through the folders or open files by clicking on them. In the example below, we clicked the folder 'Example_folder' and see that it is emtpy.
To go back up to a higher level folder, click the '.." after the first folder in the list.

: JU pyter hub Logout || Control Panel
Files Running Clusters
Select items to perform actions on them. Upload || New w || &
[(Jo ~ | B/ Example_folder Name Last Modified File size
. een paar seconden geleden

The notebook list is empty.

Create/move/remove folders

To create a new folder inside the 'Example_folder', click the 'New' button in the top right corner. By default, this will create an Untitled folder

: JLI pyter hu I ) Logout | Control Panel
Files Running Clusters
Select items to perform actions on them. Upload || New = | &
[J0o | ~ W/ Example_folder Name ¥ Last Modified File size
[l een paar seconden geledan

(0 O Untitled Folder een paar seconden geleden



You can change the name by selecting the checkbox in front of the folder and click ‘rename’

~ Jupyterhub

Logout Control Panel

Files Running Clusters

~

Fename | Move u Upload || New = || &

1 |~ | @@/ Example_folder Name Last Modified File size

een paar seconden geleden

I

[ Untitled Folder &&n minuut geledan

In the same why, by selecting the checkbox in front of the folder, you can move it (by clicking the 'Move' button), or remove it (by clicking the trash bin).

Create/move/remove files

There are a few ways to create new files.

® Click 'New' in the top right and start a notebook (in the example below, a Python 3 or R notebook). This will start a notebook, which will
automatically create an 'Untitled notebook' file that you can rename later (in the same way as you rename a folder).

Logout Control Panel

~ Jupyterhub

Files Running Clusters
Select items to perform actions on them. Upload &
Motebook:
[Jo | - W/ Example_folder Name ¥ le
{  Python 3 f

eenpaar! R

O .
(J 3 Untitled Folder { other
Text File
Folder
Terminal

® Click 'New' in the top right, and start a Text file. This will automatically create an 'Untitled' text file, that again you can rename (in the same way as

you rename a folder).
® Upload a file (or multiple files) by clicking the 'Upload' button in the top right.

Download files

To download a file, select it, and press the download button:



: Ju pyterln b Logout | Control Panel

Files Running Clusters

Duplicate | Rename @ Move | Download || View | Edit n Upload | Meww- 20
1|~ W Name« | LastModified File size
(] O Example_folder &én uur geleden
& Course_01.ipynb 16 minuten geleden 939B
0 & Course 02.ipynb een paar seconden geleden 726

Unfortunately, it is not possible to select multiple files and download them all at once. This is a general limiation of Jupyter Notebook servers.

Starting a notebook

As said, one of the ways to create a new file is by starting a notebook through the 'New' menu on the top right. In the ‘New' menu, all Notebooks that can
be started are show under the 'Notebook' header. In this example, you can see that the currently running Jupyter Notebook server supports Python 3 and
R notebooks. Note that you may see other Notebooks apart from these two: in that case SURF or your teacher has installed additional Notebooks that can
be started.

: Jupyterlml'z Logout | Control Panel
Files Running Clusters
Select items to perform actions on them. Upload o
| Motebook: I
[J0 | - W/ Example folder Name le
{  Python 3 f
= eenpaar! R
(1 3 Untitled Folder I
Text File
Folder
Terminal

When you start a new Notebook, a new tab opens in your browser, that shows the running Notebook. For example, in an empty notebook, you would see:

: Jupyterlml'} Course 07 unsaves cranges) Logout | Control Panel
File Edit View Insert Cell Kemel Help Trusted |Kernel @]
B+ = & B 44 4% MRnm B C W Code v| | &=
In[ ]:

Working in a notebook



Running code

A Jupyter Notebook is essentially en environment in which you can combine text, code, and output. For this section, we will assume you are running a
Python Notebook, so we will write Python syntax. As a simple example, we can write code that adds two numbers:

: Jupyterhul'> Course 07 (unssves changes) Legout | Control Panel
File Edit View Insert Cell Kemel Help Trusted | #* |Kernel @]
+ 3= @ B 4+ 4% MHMRun B C M cCode v | | E3

I In [ ]: 1+2|

There are multiple ways to execute this code. The first option is to go simply select the cell you want to run, and press 'Run’. Another option is to go to the
'Cell' menu, and click on of the 'Run’ options. If you hover over these menu items, a tooltip will explain exactly what each item does.

: Jupyterhu b CDUFSQ_G'1 (sutosavad) Logout | Control Panel
File Edit View Insert Cell Kemel Help Trusted |Kernel O
+ = A DB o+ b Run Cells v| | &

Run Cells and Select Below

Run Cells and Insert Below

In [ ]: 142 Run All
= Run All Above F
Run All Below
Cell Type »
Current Outputs »
All Output 3

Finally, you can run cells using shortcuts. For example, to run the current cell, press shift + enter. Note that there are many more shortcuts; you can click
the keyboard icon to see a full list.

After running the cell, we also see the output

: JUpytE‘rhUl) COUI’SQ_O'1 (unsaved changes) Logout Control Fanel
File Edit View Insert Cell Kemel Help Trusted |Kernel O
B 4+ = @& B 4+ 4 MRun B C | W cCode v | | 3
In [2]: 142
out[2]: 3

In [ ]:



A new code field has automatically appeared in this case. You can also add new code fields by pressing the '+' button, or cut, copy and paste code fields
with the corresponding buttons. With the arrow buttons, you can move the current code cell up or down.

Interrupting a calculation

You may want to interrupt a calculation, e.g. because it is taking very long and you found out you made a mistake in your code. You can either press the
'stop' button, or go to the 'Kernel' menu and press 'Interrupt'.

: JUpytEH'LI}.‘ Course 01 (susszves) Logout | Control Panel
File Edit View Insert Cell Kemel Help Trusted |Kernel @]
B+ = & B 4+ <% MRun Intermupt v | =
Restart
Restart & Clear Output
In [2]:  1+2 Restart & Run All
out[2]: 3 Reaconnect
Shutdown
In [ ]
Change kernel b

Restarting the kernel

Sometimes, you may also want to restart the 'Kernel'. The Kernel keeps all your variables in memory. While you can always override existing variables that
you have assigned, maybe you want to be sure to get a 'clean’ start (for example to test if your complete Notebook runs without errors). In that case, you
can restart the kernel with the circular arrow button, or by going to the 'Kernel' menu and pressing 'Restart'.

Writing text

You can convert the current cell to a text cell by going to the dropdown menu that says 'code’ and change it to '"Markdown'.

: JU p}!’tE‘H 1U I CDU rse_ﬂ1 (unsaved changas) Logout Control Panel

File Edit View Insert Cell Kemel Help Trusted | Kernel O

B <+ = & B 44 % MHMRun B C W | Markdown v| | E

Raw NEConvert
Heading

In [2]: | 142

OQut[

(=]
—
(V3 )

Now you can type text in a markup language called 'Markdown'. For example, to create a header:



l : JU pyter | J COU FSQ_'CH {unsaved changes) Logout Control Panel
File Edit View Insert Cell Kemel Help Trusted | # |Ke’ne| o}

B+ & @ B | 4+ % MRun B | C W Makdown v | &3

# My Header|

In [ ]:

Now, when we execute this cell (just like we would execute code), the text will be formatted:

I : Jupyter | J CDU I’SQ_@'1 {unsaved changes) Logout Control Panel
File Edit View Insert Cell Kemel Help Trusted | Kermnel O
= + & & | It + ¥ HMEun B C M | Code W =
In [2]: | 1+2
out[2]: 3

My Header

In [ ]:

For more information on how to write formatted text in Markdown, search the web for a Markdown tutorial.

Saving your notebook

While Jupyter Notebook will autosave your notebook at regular intervals, it is good practice to save your notebook regularly yourself. You can save it under
the current name with the floppy disk icon on the left. If you want to save your notebook under a different name, you can go to the 'File' menu and click
'Save as'.

Closing your notebook

Go to 'File' and click 'Close and Halt'. This will stop the notebook and close the current browser tab. After shutting down, all objects in memory will be
deleted, so the next time you start your notebook, you would have to re-execute the cells (though of course any printed output will still be there, even
without re-executing).

Note that if you just close your tab without shutting down the notebook, the notebook will keep running. This is indicated by the green icon and the
'Running’ word in the browser view.



j JU p)"'fer y | / Logout Confrol Fanel

Files Running Clusters
Select items to perform actions on them. Upload || New » || &
Oo | ~ Wi Name«  LastModified  File size
(] O Example folder &én uur geleden
O & Course 01.ipynb Funning 7 minuten geleden 939B

It's not a big issue if a notebook is still running, it means you can continue with it where you left off (though all notebooks will be shut down once the
Jupyter Notebook server shuts down). It does however mean that your notebook will still consume memory. If you have many (large) notebooks
simultaneously in a running state, you may run out of memory. To avoid this, either open it again, and go through the 'File’ menu to 'Close and Halt' your
notebook. Or, from the browser view, you can select the checkbox in front of the notebook, and press 'Shutdown'.

j Jupyter 10 Legout | Control Panel
Files Running Clusters

Duplicate D View || Edit ﬂ Upload | New~ || 2
EH1|~ W Name Last Modified File size
[J [O Example_folder &en uur geleden

& Course 01.ipynb Funning 11 minuten geleden 939 B

Alternatively, go to the 'Running' tab for an overview of all your running notebooks, and shut it down there by pressing the 'Shutdown' button:

j JUP)"(E‘I' | / Logout Control Fanel

Files Running Clusters

0@

Currently running Jupyter processes

Terminals =

There are no terminals running.

Motebooks =

& Course 01.ipynb een paar seconden geleden

Shutting down your notebook server

Your Jupyter Notebook server will remain running, even if you close your browser tab, or log out from the JupyterHub. This allows you to reconnect to a
running notebook when e.g. your internet connection is shortly interrupted. For the homework profile, an inactivity timeout is active that will make sure
that a Notebook server remains idle for a while (10-20 minutes or so) will shutdown automatically. This timeout is not in place for the course profile; here
your notebook will be automatically shutdown at the end of the course hour reservation.

You can also shutdown your server manually. This opens up a slot for other notebooks immediately, which will be appreciated by your fellow students
when all slots in the homework profile have been filled up. To shutdown your notebook, click the "Control Panel" button in the top right, and then click the

"Stop My Server" button:



"~ Jupyterhub Home  Token

Note that it may take around 10 seconds for the server to be stopped. If you don't see changes, try refreshing the page.

Logging out from the JupyterHub environment

Logout

You can log out from the JupyterHub environment, by using the Logout button in the top-right corner.

Advanced topics

Downloading/uploading large numbers of files

The quickest way to upload or download a large number of files is by connecting to Lisa through an FTP client. This is explained in the Lisa documentation:
https://userinfo.surfsara.nl/systems/lisa/user-guide/connecting-and-transferring-data#sftp


https://userinfo.surfsara.nl/systems/lisa/user-guide/connecting-and-transferring-data#filecopy
https://userinfo.surfsara.nl/systems/lisa/user-guide/connecting-and-transferring-data#sftp
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